RefWorks

Logging In

¢ Access www.refworks.com/refworks and
select the “RefWorks 2.0” interface
option. Enter your personal Login Name
and Password. (First-time users need to
sign up for an individual account
following the screen prompts.)

NOTE: Remote users, accessing
RefWorks from off-site or from a non-
registered IP address, must either enter
the “Group Code” prior to the personal
Login Name and Password or log-in via
the organization’s proxy server.

www.refworks.com

RefWorks 2.0

Quick Start Guide

Need More Help?

Online Tutorial

A tutorial providing explanations of various RefWorks functions is
available online, along with an Advanced User and RefShare Tutorials.
Use the Help pull-down menu to access the tutorials.

Support

Online
Use the Help pull-down menu to access detailed instructions,
frequently asked questions, administrator tools and much more.

E-Mail
Send questions or problems to support@refworks.com.

Webinars

RefWorks-COS now offers complimentary training webinars on
RefWorks 2.0. Fundamentals and Advanced Feature sessions are also
available. A complete listing of sessions can be found on the RefWorks
homepage. New dates and time are added monthly.

Phone
Contact RefWorks Technical Services at +1.775.327.4105.



Creating Your RefWorks Database

RefWorks provides a number of options for adding data to your database.

Importing Data Directly
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1. Under the save or export function within the online service,
select or click onto the save to RefWorks option. [¥1

2. If you have your RefWorks account already open, the
import will automatically begin. If not, then you will be
prompted to the RefWorks login page; after you login, the
import will automatically begin.

3. Select the Folders tab, then Last Imported to review the
imported records.

Helpful Hint: Every reference added to RefWorks (whether imported
or entered manually) is given a print or electronic designation called
Source Type. This assists in ensuring you have all the relevant data
REQUIRED in your bibliography. A default Source Type may have
been set by your local Administrator. Users can set their own source
type in Customize area. m

Converting References from Other
Bibliographic Management Products

RefWorks is compatible with a number of other bibliographic
management products. You can easily convert an existing
bibliographic management database such as EndNote into
RefWorks. For details related to importing data from specific
individual bibliographic management products, please refer to
the online Help section of RefWorks.
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Importing Data from Saved Text Files
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References can be imported into RefWorks from a text
file (.txt) created by saving references from a wide variety
of online services and other bibliographic management
programs.

1. Retrieve the results you want to export from the online
service or bibliographic manager, and save them to a text
file. If the database vendor lists several different formats
for saving the references, see the RefWorks Help file for
further details on the appropriate selection.

2. Access your RefWorks account and click References from
the drop-down menu; then select Import.

3. On the subsequent menu, access the drop-down menu next
to Import Filter/Data Source and click the source of the
data. [E3

4. Click on the Database drop-down menu and select the
source database.

5. Click on the Browse button to select the text file to import.

6. Click on the Import into Folder drop-down menu to
designate the specific folder where you want to file the
imported references. If you do not choose a folder, the
references will automatically go into the Last Imported
folder.

7. Click on Import. When the import is complete, select the
Folders tab and the Last Imported folder to review and
modify the imported references.

Helpful Hint: An up-to-date listing of all online services and databases
that are supported by RefWorks can be found in the Import area by
clicking on the List of Filters and Databases link.

Importing from RSS Feeds

RefWorks has integrated an RSS Feed Reader so you can easily
add your favorite RSS Feeds from publishers and websites,
view the information and import data into your RefWorks
database.

1. Locate the RSS Feed you wish to include.

2. Right mouse-click on the RSS Feed icon or link and select
Copy Shortcut.

3. From within RefWorks, select RSS Feed from the Search
Menu.

4. Paste the shortcut into the text bar and click the Add RSS
Feed button.

5. Launch the RSS Feed by clicking on the name link. Your
feed results will be displayed in a separate window for
selection and importing.



Creating Your RefWorks Database (i

RefWorks provides a number of options for adding data to your database.

Manually Entering References
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1. Click on the New Reference button.

2. Select a potential bibliographic output style (e.g., APA,
Chicago, MLA) under View fields used by to enable the
AccuCite feature.

3. Designate the type of reference you are entering (e.g.
journal, book or dissertation) under Ref Type. The field
names that are associated with the specific output style
and reference type you chose will appear, indicating
recommended information needed to produce an accurate
bibliography. These fields are not required to save the
actual reference in RefWorks. To view additional fields,
click on Additional Fields on the bottom left of the screen.

4. Enter information in the boxes provided and click the
appropriate Save button when finished.

Attaching Files to a Reference
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You can attach files when adding a new reference manually
or editing an existing reference. Attachments can be any
type of computer file (PDF, TIF, JPG, GIF etc.) that you want to
associate with the bibliographic information you store in your
RefWorks database. For further instructions on attaching files
to your references, please refer to the Help file.

1. Select a reference in your database; click on the Edit
button (|.7).

2. Click on Browse. Select a file to attach. Select Open. E

3. Click on Add attachment.

Helpful Hint: There is no limit to the number of files you can attach
to a reference. The maximum size of any individual attachment is
20 MB.

Importing from Online Catalogs or
Databases
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You can use RefWorks as a search interface for a number of
online resources. [[3 RefWorks provides access to a number
of publicly available services such as NLM’s PubMed as well as
many universities’ Online Catalogs. Additionally, institutional
subscribers may also provide access to subscription-based
online services (e.g., Ovid or ProQuest) through RefWorks.
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Online Database

1. From the Search pull-down menu, select Online Catalog or
Database.

2. Select a database from the Search drop-down menu.

3. Select the Max. Number of References to Download from
the drop-down menu.

4. Enter terms in either the Quick Search for: or run an
Advanced Search by clicking on the triangle in the
Advanced Search for: box to enter terms.

5. Click on Search to begin your search. A new window will
open displaying your search results.

6. Select the references you wish to import into your
RefWorks account and click Import. 3

Technical Services



Managing and Sharing Your References

RefWorks provides you with a number of tools to organize, edit, find, and view references in your database.

Creating Folders
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1. Click on the New Folder button (| g).
2. Enter a name in the text box; click Create. B

There is no limit on the number of folders you can create
within your RefWorks account.

Helpful Hint: The Last Imported folder contains only references from

your most recent data import that have not been filed in other folders.

References from imports prior to your last import not assigned to
specific folders remain available in your primary database but unfiled.

Putting References into Folders
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1. Mark desired references from the search results page, then

click the button titled Selected. The selected references

feature works on a page-by-page basis; this means that you

must add the manually selected references to the desired

folder before moving to the next page. Alternatively, you

can mark All or all on a Page.

Select folder from the Move To: drop-down menu. [[fJ

4. References will automatically be added to the indicated
folder.

w

Helpful Hint: References can be assigned to more than one folder.

Technical Services

Sorting References

1. From either the View pull-down menu or the Folders tab,
select a folder or group of references.

2. Using the pull-down menu Sort by, located in the toolbar
above the references, choose to view references by various
fields within your database.

Globally Editing References
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1. From the main navigation area, click on the Global Edit

button ().

Select the references you wish to edit.

The Add option is displayed by default.

Choose the specific field to edit from the drop-down list. n

Type in the data you want to add to the field in the text

field box.

6. Select the appropriate option for handling the field -
Append to Existing Data; Overwrite Existing Data (what
you currently have in the field will be gone); Leave Existing
Data Alone (if the field contains data the edit feature will
skip over that particular reference).

7. Click on Add Data .

Helpful Hint: RefWorks also offers the ability to Move, Delete, or
Replace information in records. For more information on these
additional Global Edit functions, please see the Help file.
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Managing and Sharing Your References conine

RefWorks provides you with a number of tools to organize, edit, find, and view references in your database.

Quick Search

Use the Quick Search feature as a search of all fields. To produce
maximum results, all search terms entered are connected
by the Boolean connector OR. In addition, searches retrieve
embedded terms - a search for “art” retrieves references with
“heart,” “part,” etc. The results of a Quick Search are always
ranked by relevancy.

1. Enter search terms in the Search your database box.
2. Click on GO.
3. Results are displayed with the search terms highlighted.

Advanced Search

Sharing Your References
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Advanced Search makes it easy to perform field-specific
searches (e.g., Author, Title, Keyword), construct Boolean
queries (i.e., AND, OR, NOT), and limit the search to a specific
folder(s). The results of an Advanced Search are displayed
alphabetically by author, with the search terms highlighted.

1. Click on the Search drop-down menu and select Advanced. [l

2. Enter search terms and corresponding fields into the
Advanced Search menu. Click on (&) to add more fields.

3. Connect the terms by using the Boolean operators.

Select All References or specific folders to search.

5. Click on Search.

E

Helpful Hint: You now have the option to save search strategies.
Search strategies can be named and saved for easy and continual
retrieval.
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Note: During the RefWorks 2.0 Beta Release - RefShare will
revert back to the classic interface. This feature will not reflect
the RefWorks 2.0 user interface until it is officially launched.

You can share a folder of references or your entire database.
RefShare is not automatically available for all RefWorks users.

1. From the Tools pull-down menu, select Share References. m

2. Select the folder you wish to share and click Share Folder.
To share all of your references in your account, click Share
Entire Database.

3. Select desired Shared Folder Options which allow you to
define any use restrictions you wish to set for the RefShare
Recipient(s).

4. Click on E-mail URL. A new window will open with a generic
e-mail template and a unique URL created for your
RefShare folder. Insert the e-mail address of the
individual(s) you would like to share your references with.
Select Send E-mail.

Note: As the owner of the folder or database, you determine the
options your RefShare Recipients(s) will have in utilizing your shared
references.



Creating Your Paper and Bibliography

RefWorks creates bibliographies from over 1,000 output styles in seconds.

Format a Bibliography From a List of
References
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Click on the Create Bibliography button.

Select an output format (i.e., APA, MLA, Chicago, etc.).
Click on Format a Bibliography from a List of References.
Select what file type to create.

Select to format all of your references or those references
from My List or from a specific folder.

Click on Create Bibliography.

A new window will open with your bibliography.

8. Save your bibliography to your computer or disk.
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One Line/Cite View Paper
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1. From any reference view (all references, a folder or search
results), click on the Change View dropdown and select
One Line/Cite View.

2. Click on the Cite icon (. ;) on the right side of the
appropriate reference. A Citation Viewer window will
appear containing the citation in an abbreviated format.

3. To cite a second reference in the same location just click
on the Cite icon by any other reference. If you are using a
Mac, you will need to click twice - the first click will activate
the RefWorks program and the second will perform the Cite
function. [

4. Once you have all of the references you need for a
particular in-text citation, click on the Select button.

5. Perform a copy command or simply drag and drop the
citation into your word processor document.

6. Go to your word processor, click on the document where
you want the citation inserted and Paste the citation.

7. Be sure to clear the Citation Viewer window before creating
your next citation.

8. Click on the View icon () to see the entire reference and
to access the Edit command if you want to make changes.

One Line/Cite View Bibliography

1. Save the document you have just created before formatting
the paper and the bibliography.

2. Click on the Bibliography button from within the RefWorks
program.

3. Select the Output Style you need and use the Format Paper
and Bibliography option to browse for the document.

4. Click on Create Bibliography.

Direct Exports Available From:

e 1Cate e ABC-CLIO e ACS Publications e bibliotek.dk
e BIBSYS e BioMed Central ¢ BioOne e Blackwell Synergy
e CABle CAIRN e Chadwyck-Healey ¢ Compludoc ¢ CQ Press
e CSA lllumina e CSIC e DanBib - Danish Bibliographic Centre
e Dawson Books ¢ DBPIA ¢ Deep Web Technologies
e Dialnet ¢ ebrary ¢ EBSCOhost e Engineering Village 2
e FIS Bildung ¢ Google Scholar ¢ GoPubMed e HighWire
e HubMed e IEEE e Informit
e Japana Centra Revuo Medicina (& -5 Web) ¢ JSTOR
e LexisNexis Academic ¢ Metalib
e Microsoft Live Search Academic ¢ Newsbank e NISC
e OCLC ¢ OCLCPICA - ZPORTAL ¢ Ovid e Project Muse
e ProQuest ® QUOSA e RISS4U e RLG's Eureka e Sabinet
e ScienceDirect e Scitopia.org ® Scopus e Serials Solutions
e SFX e SilverPlatter ¢ Stat!Ref
e The R2 Digital Library (Rittenhouse Book Dist.)
e TDNet e TicToc ¢ Thomson Gale via OpenURL Link
e Ulrich’s Resource Link ¢ University of California Press
e Wanfang Data Corp. ® WebFeat
e WilsonWeb via WilsonLink
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